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Wprowadzenie 

Ebook tworzony jest na podstawie programu Blender 4.x. 

Ebook jest dodatkiem do Kursu https://astraja.com/blender/   i zawiera skrócone, 

najważniejsze informacje przedstawiane w kursie wideo. 

Wszelkie uwagi, chęć pomocy, informacje o błędach prosimy kierować na adres: 

astraja.pro@gmail.com 

 

Link do materiałów na dysku google: 

https://drive.google.com/drive/folders/18G04fd3VXMEJaqzZk7_l4vCWjkgAUBtH?usp=sharin

g  
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Podstawowe skróty w Blender 

G, R, S Przesuń, Obróć, Skaluj 

Shift + A Wstawianie obiektów 

Ctrl + A Wywołanie menu do aplikowania transformacji 

Shift + D Duplikowanie 

Tab Przełączanie pomiędzy Object Mode i Edit Mode 

Ctrl + L Linkowanie (np. materiału)  

Shift + S Snap Menu 

Ctrl + J Join (Łączenie obiektów w jeden) 

Ctrl + P / Alt + P Parent / Clear parent 

H / Alt + H Ukryj / pokaż obiekty 

N Menu dodatkowe 

 

Num0 Przełączanie widoku z kamery 

Num 1, 3, 7 Widok z przodu, prawej, góry 

. Fokusuj na zaznaczonym obiekcie 

F12 Render 
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Skróty w Edit Mode 

E Extrude 

Alt + E Extrude menu 

I Inset faces 

Ctrl + B Bevel 

Ctrl + R Loop cut 

K Knife 

V Rip region 

C Circle select 

L Zaznacz połączoną geometrię 

Alt + LMB Zaznacz loop 

Ctrl + +/- Zaznacz/odznacz sąsiadujące wierzchołki 

M Merge menu 

P Separate 

F Wstawianie ścian 

 

 

Skróty Shading i Geometry Nodes (Wrangler addon) 

Shift + W Szybkie menu 

Ctrl + RMB Drag Przerwij połączenie 

Alt + S Zamień wejścia 

Ctrl + Shift + LMB / O Podgląd zaznaczonego nodu 

Backspace Reset nodu do ustawień domyślnych 

Ctrl + T Dodaj zestaw nodów tekstury 

Ctrl + 0 / Ctrl + Shift + RMB drag  Połącz zaznaczone nody z Mix node 

Ctrl + G Grupuj zaznaczone nody (TAB open/close) 

Ctrl + X Usuń nod z zachowaniem połączenia 

Alt + LMB Drag Rozłącz nod z zachowaniem połączenia 

Ctrl + Shift + D Duplikuj połączony nod 

Shift + RMB drag Dodaj gniazdo połączenia (Ctrl + X – usuń) 

 

https://www.astraja.com/


____________________________________________________________________________________________________________ 
 

 A S T R A J A      BLENDER PROJEKTOWANIE 3D  [ 8 ] 

Teoria kolorów 

Koło barw RGB (color wheel) 

Kolory określa się na podstawie koła barw. 

 

            

 

 

Koło barw: https://color.adobe.com/create/color-wheel  

 

Wpływ kolorów na odbiór: 

• Służy do ukierunkowania widza na czym ma skupić swoją uwagę 

• Opowiada historię 

• Wprawia w odpowiedni nastrój 
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Kolory RGB, HSV, CMYK 

 

 

RGB (Red, Green, Blue) 

Kolory na ekranie komputera tworzone są w sposób addytywny, poprzez dodawanie 

składowych kolorów podstawowych emitowanych przez diody LED: 

R – czerwony, G – zielony, B – niebieski. 

Każdy z tych kanałów przyjmuje nasycenie danego koloru w postaci liczby (0.0 – 1.0). 

Synteza wartości tych 3 kanałów tworzy barwę końcową. 

Przykładowy kolor powyżej można zapisać w postaci struktury Color (0.6, 0.4, 0.7) 

 

  

https://www.astraja.com/


____________________________________________________________________________________________________________ 
 

 A S T R A J A      BLENDER PROJEKTOWANIE 3D  [ 10 ] 

HSV (lub HSB) - Hue, Saturation, Value (Brightness) 

Hue Odcień koloru na kole barw. Wartość mieści się w zakresie 0-360 stopni, gdzie 0 i 360 

reprezentują ten sam kolor (czerwony). W blenderze wartości 0-360 mapowane są na 

zakres od 0.0 do 1.0. 

Saturation Określa intensywność (nasycenie) koloru od 0.0 do 1.0. 

Value (Brightness) Określa jasność koloru od 0.0 do 1.0. 

System HSV, dzięki swoim właściwościom,  pozwala na łatwiejszy wybór kolorów i 

tworzenie odpowiedniej kolorystyki dla całej kompozycji. 

 

CMYK 

To system ubytkowy (subtractive), używany do malowania i druku. Kolory w naturze ( w 

odróżnieniu od kolorów emitowanych na monitorze) absorbują światło (poszczególne 

długości fal, które odpowiadają za dany kolor). 

W systemie CMYK stosowane są kolory podstawowe: Cyan, Magenta, Yellow oraz Black do 

podbicia głębi czerni. 

 

Barwy podstawowe 

Podstawowe kolory to dowolny zestaw kolorów, które mogą reprodukować wszystkie inne 

kolory poprzez ich mieszanie. Sposób mieszania określa, jakie kolory są uznawane za 

podstawowe. W grafice, ważne są dwie grupy podstawowych kolorów: addytywne RGB i 

subtraktywne CMY(K). 

W programie Blender głównie skupiamy się na systemie RGB. 

Biel i czerń uważane są za kolory neutralne i nie wliczają się bezpośrednio do kolorystyki / 

palety barw. 
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Kolory pochodne 

Kolory pochodne (complementary) powstają przez zmieszanie kolorów podstawowych, są 

to: cyjan, magenta i żółty dla modelu RGB. Jak można zauważyć kolory pochodne RGB to 

również kolory podstawowe systemu CMYK. 

 

Kanał Alpha 

Alpha to kanał oznaczający przezroczystość, przyjmuje wartość od 0.0 do 1.0 ( lub 0 – 255), 

gdzie 0 to pełna przezroczystość, a 1 to brak przezroczystości. 

Zapisywanie plików graficznych z kanałem alpha 

RGBA wymaga odpowiedniego formatu, np.: 

PNG jest w stanie zapisać 256 stopni 

przezroczystości (w standardzie 8bit) 

GIF zapisuje tylko 0 lub 1 (pełna przezroczystość lub jej brak) 

JPG nie zapisuje przezroczystości (obszary przezroczyste spłaszczane są do koloru 

czarnego, w innych programach może to być kolor biały). 

 

Kanał alpha w silniku Eevee 

Poprawne wyświetlanie kanału alpha w silniku 

Eevee (Viewport i Render) wymaga włączenia 

opcji Transparent w  

menu Render / Film  

 

Poprawne wyświetlenie przezroczystości w 

tworzonych materiałach wymaga wybrania 

opcji Blend Mode / Alpha  

w menu Material / Settings  

Harmonia barw 
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Układy kolorów 

Monochromatyczne (monochromatic) – różne nasycenie i 

jasność tego samego koloru. 

 

Paletę kolorów monochromatycznych tworzy się przez 

miksowanie koloru podstawowego z kolorami neutralnymi: 

białym, szarym i czarnym.  

Mówiąc o danym kolorze, należy brać pod uwagę również jego różne odcienie. 

 

 

Pochodne (complementary) – kolory i ich odcienie, które 

znajdują się naprzeciw siebie na kole barw 

Przykładowe palety: 

 

 

 

 

 

 

Pochodne rozdzielone (split complementary) – kolor na 

naprzeciw zostaje podzielony na 2 kolory sąsiadujące 

Przykładowe palety: 
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Analogiczne (analogous) – 3 kolory i ich odcienie sąsiadujące 

na kole barw 

Przykładowe palety: 

 

 

 

 

 

 

Triada (triadic) – 3 równo rozłożone kolory (zazwyczaj stosuje 

się 1 kolor dominujący, a pozostałe 2 jako dodatki) 

Przykładowe palety: 
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W jaki sposób wybrać barwy w kompozycji 

1. Wybierz kolor dominujący 

2. Wybierz paletę kolorów zgodnie z wybraną harmonią barw na podstawie koła barw 

lub gotowych palet dostępnych w internecie 

3. Używaj tylko kilku kolorów, zbyt duża ilość wprowadza chaos i dezorientację 

 

Siła oddziaływania kolorów 

Barwy posiadają siłę oddziaływania (wartość świetlną), ustaloną przez Goethe. Należy je 

łączyć w odpowiednich proporcjach, aby zachować odpowiednią harmonię miłą dla oka. 

Siła barw:  

Żółty – 9 

Pomarańczowy – 8 

Zielony / Czerwony – 6 

Niebieski – 4 

Fioletowy – 3 

 

Im większa siła danej barwy, tym mniej jej powinno znaleźć się w kompozycji. 
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Dystrybucja barw 

Ludzkie oko potrafi rozróżniać poziomy czerni i bieli, dzięki czemu widzimy gradient 

szarości od czarnego do białego. W naturalnym środowisku mamy do czynienia z 

dystrybucją liniową (Linear), która wygląda następująco: 

Linear 

 

W przypadku obrazów zapisywanych czy wyświetlanych na monitorze, taka głębia odcieni 

jest nieefektywna, ponieważ jasne odcienie zajmują zbyt dużo miejsca i zdecydowanie 

dominują nad odcieniami czerni. Aby zachować równowagę stosuje się konwersje 

kolorów, tzw. gamma correction. Powoduje to większe nasycenie kolorem czarnym i 

równomierne rozłożenie odcieni na palecie: 

Gamma 

 

W blenderze spotykamy się ze skalą liniową i skalą Gamma.  

 

https://www.astraja.com/
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W uproszczeniu można przyjąć, że w blenderze: 

• kolory tworzone za pomocą liczb 0.000 do 1.000 są opisywane w skali liniowej 

Linear sRGB 

• kolory tworzone za pomocą liczb 0 do 255 są opisywane w poprawionej skali 

Gamma sRGB (mogą też być zapisane w postaci szesnastkowej HEX, co znacząco 

ułatwia kopiowanie). 

 

Zamiana kolorów przeprowadzana jest w blenderze automatycznie. Manualnie możemy 

dokonać konwersji Linear sRGB (0.0 – 1.0) <-> sRGB (0 – 255) za pomocą dostępnych 

konwerterów. 

Konwerter kolorów: https://ajalt.github.io/colormath/converter/  

 

Konwersja Linear sRGB <-> sRGB jest złożonym procesem i nie polega na zmapowaniu 

wartości 0.0 – 1.0 na 0 – 255! 

 

https://www.astraja.com/
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Konwersja Color RGB do Fac 

Color to struktura złożona z trzech wartości typu float( od 0.0 do 1.0), np. (0.6, 0.4, 0.7).  

Fac to scalar, pojedyncza wartość od 0.0 do 1.0. 

Podłączenie wyjścia Fac do Color w Blenderze wiąże się z konwersją pojedynczej wartości 

do struktury Color. W tym przypadku każdy kanał koloru RGB otrzymuje wartość 

wyjściową Fac. 

Zamiana Color na Fac wygląda zupełnie inaczej, w tym przypadku następuje konwersja 

na podstawie Luminance (Luma) w standardzie  REC.709. 

Wartość każdego kanału koloru RGB mnożona jest przez zdefiniowane w standardzie 

stałe, a suma wyników daje wartość Fac. 

Luma weights = 0.2126*R + 0.7152*G + 0.0722*B 

 

Przykład: 

Kolor RGB [0.6, 0.4, 0.7] 

Luma(Fac) = 0.2126 x 0.6 + 0.7152 x 0.4 + 0.0722 x 0.7 = 0.464 
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Shading 

Node 

Tworzenie materiałów odbywa się w panelu Shading za pomocą nodów. Poprzez 

połączenie odpowiednich modułów można stworzyć dowolny materiał. Sekwencja 

tworzenia nodów przebiega od lewej do prawej strony. 

Istnieje wiele nodów różnego typu, które można dodać za pomocą Shift + A.  

Nody, w zależności od typu, zawierają gniazda wejściowe i wyjściowe (sockets) oznaczone 

różnymi kolorami. Kolor pinu decyduje o typie przyjmowanej / przekazywanej wartości. 

 

W przypadku stosowania tekstur, dane są kolekcją (mapą) tysięcy / milionów wartości 

(map value). Każdy punkt / pixel na obiekcie ma przypisaną swoją własną wartość np. 

kolor.  
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Konwersja wartości 

Piny w nodach oznaczone są kolorystycznie, aby łatwiej było je łączyć na podstawie 

przekazywanych wartości. Często zachodzi potrzebą łączenia nodów o różnych typach. W 

wielu przypadkach dochodzi do konwersji wartości.  

Pewne konwersje zachodzą automatycznie, np.  

float -> color, ustawi wszystkie składowe koloru na podstawie liczby float 

color -> float zamieni barwę na skalę szarości 

Podczas konwersji może dojść do bezpowrotnej utraty informacji i zmiany jednostek. 

Część konwersji nie może być przeprowadzona automatycznie i wymaga specjalnego 

nodu, np. Bump node. 
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Shader 

Shader to program, który wyświetla dane graficzne.  

Shadery definiują jak światło i cienie oddziałują z powierzchnią obiektów, co wpływa na 

ich wygląd w renderowanym obrazie. W blenderze shader określa materiał z którego 

zbudowany jest dany obiekt, np.: szkło, plastik, metal, itp. 

 

Najczęściej stosowanym shaderem w Blenderze jest Principled BSDF. 

Shadery można łączyć za pomocą nodu Mix Shader. 

 

W blenderze bardzo wiele operacji bazuje na kolorach i wartościach od 0 do 1.  

Kolory również wyznaczają wartości, czarny = 0, a biały = 1.  
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Normale 

Normal to prostopadły wektor danego obiektu, w 

blenderze mogą to być normale ścian lub 

wierzchołków. Normale wpływają na sposób 

reagowania powierzchni ze światłem. 

Face normals wyznacza kierunek w którym 

skierowana jest ściana. 

 

Vertex normal (niebieski) wyznacza 

kierunek na podstawie dołączonych do 

danego wierzchołka krawędzi. 

Vertex split normal (różowy) pokazuje 

osobny kierunek dla każdej dołączonej do 

wierzchołka krawędzi. 
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Cieniowanie obiektów 

Normale grają kluczową rolę przy cieniowaniu obiektów. 

Shade smooth korzysta ze średniej wartości wierzchołka dzięki 

czemu ostre krawędzie stają się zaokrąglone. 

Vertex split normal jest wykorzystywany podczas wyświetlania opcji Shade Flat, gdzie 

widać wyraźną różnicę między ścianami.  

Przy opcji Shade Auto Smooth normale 

są dobierane ze względu na ustawiony 

kąt między ścianami. Poniżej danej 

wartości program korzysta z vertex split 

normals, a powyżej z vertex normals. 

Krawędzie mogą być ustawione jako mark sharp, dzięki czemu zawsze będą wyświetlane 

w sposób ostry. 

 

Normale pokazują orientację ścian, dzięki czemu 

wiadomo w którą stronę ściana jest skierowana.  

Można to zobaczyć za pomocą pola Face 

Orientation w menu Show Overlays. 

Prawidłowa orientacja ścian jest istotna przy 

renderowaniu materiałów, działaniu 

modyfikatorów, a także podczas exportu. 

Przednia (zewnętrzna) strona ściany oznaczona 

jest kolorem niebieskim, a tylna ściana kolorem 

czerwonym.  

Ich kierunek można zmieniać za pomocą menu 

Mesh > Normals (Alt + N) w Edit Mode. 
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Bakowanie Image texture z wielu materiałów 

  

 

Rozłóż siatkę UV obiektu (UV Mapping > Unwrap). 

 

W panelu Shading dodaj nod Image Texture i stwórz nową teksturę. 

 

Załaduj utworzoną teksturę do noda i kliknij na nim, aby był aktywny. Nod nie powinien 

być do niczego podłączony.  

Skopiuj utworzony nod do wszystkich pozostałych materiałów. 
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Bakeowanie można przeprowadzić tylko w 

silniku Cycles 

Dostosuj ustawienia do bakowania koloru 

poprzez zmianę Opcji Bake Type (Diffuse) i 

Contributions (Color). 

Kliknij przycisk Bake. 

Na koniec zapisz zmienioną teksturę do 

pliku graficznego, np. w workspace UV 

Editting: Image > Save As 

Stwórz nowy materiał na bazie 

nowopowstałej tekstury. Poprzednie 

materiały można usunąć. 
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Bakowanie wielu tekstur do jednej 

Obiekty mogą mieć na sobie wiele materiałów z wieloma teksturami. Chcąc je 

wyeksportować należy połączyć wszystkie materiały w jeden. 

Stwórz nową (drugą) UV mapę w zakładce Data > UV Maps. Aktywuj ją. 

Rozłóż siatkę obiektu tak, aby wyspy nie nachodziły na siebie. 

Dodaj nod Image Texture, stwórz nową teksturę i załaduj do noda.  

Zdefiniuj UV Mapy za pomocą nodów, do starego materiału podepnij starą UV Mapę, a do 

nowopowstającej tekstury dołącz nową UV Mapę.  

 

Skopiuj nod do wszystkich wymaganych materiałów i upewnij się, że jest zaznaczony. 

Dostosuj ustawienia Bake 

Po pomyślnym procesie Bakowania, zapisz plik 

graficzny. 

Stwórz nowy materiał, który będzie korzystał z 

nowo powstałej tekstury. Poprzednie materiały i 

starą UV mapę można usunąć.  
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Materiał: Zardzewiały metal 

 

 

Materiał Fire Dissolve 
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Materiał: Zmiana koloru ze względu na odległość 

 

 

Materiał: Losowy kolor 
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Animacja 

Wstawianie klatek kluczowych 

W blenderze, klatki kluczowe można wstawiać na wiele sposobów. W oknie właściwości 

(properties), przy każdym polu, przy którym znajduje się symbol kropki, można wstawić 

klatkę kluczową. Po kliknięciu na kropkę, jej symbol zmieni się na diament, a tło pola 

zmieni kolor na żółty. 

Żółty kolor pola oznacza, że w tej klatce dodana jest klatka kluczowa (keyframe). 

Zielony kolor oznacza, że dane pole jest animowane, ale w aktualnej klatce czasu nie ma 

dla niego żadnych klatek kluczowych. 

Dużo szybszym sposobem dodawania klatek kluczowych jest użycie skrótu 

klawiaturowego  i wybór właściwości (location, rotation, scale, itd). 

 

12 Zasad animacji 

Zgniatanie i rozciąganie 

Stosowana w celu przekazania dynamiki ruchu i zjawisk związanych z odkształceniem 

pod wpływem działania sił. Stosowana łącznie z zasadą „wyolbrzymienia”, może zostać 

zastosowana zarówno do prostych obiektów, jak np. odbijającej się piłki, ale też do 

skomplikowanych struktur, np. ludzkiej twarzy. W przypadku animacji zmierzającej do 

realizmu konieczne jest zachowanie stałej objętości obiektu podczas odkształceń. Mocne 

przewartościowanie tego środka prowadzi do efektu komizmu. 

Wyprzedzanie 

Stosowane, by przygotować odbiorcę na ruch. Każde działanie poprzedzone jest 

przygotowaniem do niego – np. tancerka, żeby podskoczyć najpierw musi zgiąć nogi, 

golfista, żeby uderzyć w piłeczkę najpierw musi wykonać zamach kijem. Zasada ta może 

być pominięta wtedy, gdy widz spodziewa się jakiegoś zachowania – wtedy uzyskamy 

komediowy efekt zaskoczenia. 

I 
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Inscenizacja 

koresponduje z zasadą, której używa się w teatrze i filmie. Polega na skierowaniu wzroku 

widza w zamierzone miejsce i takie pokierowanie akcją, by dla odbiorcy stało się jasne, co 

w danym ujęciu jest najważniejsze. Doprowadzić do tego można poprzez odpowiednie 

umiejscowienie postaci, użycie światła lub cienia i odpowiednie ustawienie kamery. 

Rysowanie progresywne lub według klatek kluczowych 

To dwie metody uzyskania efektu ruchu. W metodzie progresywnej akcję przedstawiamy, 

rysując kolejne klatki jedna po drugiej, posuwając się od początku do końca. Metoda 

druga (od pozy do pozy), polega na wykonaniu klatek kluczowych, a następnie 

uzupełnieniu klatek między nimi. Metoda progresywna pozwala na uzyskanie bardziej 

dynamicznej iluzji ruchu i jest lepsza do przedstawienia realistycznych sekwencji, ale 

trudno jest w niej zachować odpowiednie proporcje i otrzymać dokładne, przekonujące 

pozy w trakcie całego ruchu. Metoda klatek kluczowych działa lepiej w dramatycznych 

lub emocjonalnych scenach, gdzie kompozycja i relacja z otoczeniem są ważniejsze niż 

sam ruch. W praktyce najczęściej łączy się obie te metody. Animacja komputerowa 

wyeliminowała wprawdzie problem proporcji w metodzie progresywnej, jednak metoda 

klatek kluczowych wciąż pozostaje w użyciu. 

Nakładanie się i podążanie za akcją 

Te dwie ściśle związane ze sobą zasady pozwalają spotęgować wrażenie realizmu ruchu 

poprzez przemieszczenia zgodne z prawami fizyki. Podążanie za akcja można opisać jako 

(bezwładne) przemieszczania części postaci lub obiektu w kierunku działania siły 

pomimo zakończenia zasadniczego procesu przemieszczania. Nakładanie się akcji to 

użycie odpowiedniej relacji czasowej pomiędzy ruchem różnych elementów (np. ręka 

poruszy się w innym momencie niż głowa lub stopa). Trzecią zasadą jest ciągnięcie – 

odnoszące się faktu, że jeśli postać zaczyna się przemieszczać, elementy będące z nią w 

relacji potrzebują jeszcze kilku klatek, by podążyć za nią. Przykładem mogą być płaszcz 

lub włosy. Podobne zachowanie wykazują obiekty organiczne, w których istnieje 

zróżnicowanie pomiędzy przemieszczeniami konkretnych rejonów ciała w zależności od 

masy i występujących sił. Podobnie jak we wcześniejszych przypadkach, mocne 

przewartościowanie efektu prowadzi do komicznego rezultatu. 

Rozpędzenie i zwolnienie 

Obiekty organiczne i większość przedmiotów potrzebuje czasu by rozpocząć ruch, lub się 

zatrzymać – trwa to tym dłużej, im większą masę, a więc i bezwładność ma dane ciało. Z 
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tego powodu animacja wygląda bardziej realistycznie, jeśli zawiera więcej klatek przy 

początku i końcu ruchu niż w jego środku – kiedy jest najszybszy. Zasada odnosi się 

zarówno do obiektów w ruchu między dwoma ekstremalnie różnymi pozami (np. 

wstający człowiek), jak i do będących już w ruchu (np. wspomniana wcześniej odbijająca 

się piłka). 

Łuki  

W procesie animacji powinniśmy uwzględnić, że ruchy obiektów organicznych zazwyczaj 

odbywają się po trajektorii łuku. Podkreślenie tego aspektu w animacji powoduje 

zwiększenie poczucia realizmu. Należy pamiętać, że przemieszczenia maszyn i urządzeń 

charakteryzują się niższą złożonością i odbywają się zazwyczaj jako ruch prostoliniowy. 

Akcja drugoplanowa  

Dodanie drugoplanowej animacji urealnia ruch i uwydatnia główne elementy animacji. 

Osoba spacerująca oprócz poruszania ramionami może gwizdać, rozmawiać z inną osobą 

lub zmieniać wyraz twarzy. Przy dodawaniu tego rodzaju ruchu ważne jest, by za jego 

pomocą raczej podkreślić ruch główny niż oderwać od niego uwagę. Ruchy mimiczne 

podczas dramatycznych ruchów ciała zazwyczaj pozostają niezauważone – lepiej jest 

dodać taki dodatkowy ruch na początku lub na końcu ruchu głównego. 

Taktowanie  

Odnosi się do czasu w pojęciu fizycznym i teatralnym. Czas ruchu musi odnosić się 

zarówno do praw fizyki, jak i do historii opowiadanej przez animację. Jeśli nie mamy do 

czynienia z przypadkiem szczególnym, zamierzonym przez twórcę w celu osiągnięcia 

odpowiedniego efektu, taktowanie jest poprawne wtedy, gdy obiekty pojawiają się 

zgodnie z prawami fizyki – np. masa określa prędkość i wpływ obiektu na pozostałe 

elementy sceny. Teatralne taktowanie jest związane raczej z doświadczeniami 

wyniesionymi z tej dziedziny sztuki. Polega na odpowiednim wyważeniu czasu ruchu, 

który prowadzi do komicznych lub dramatycznych efektów. 

Wyolbrzymienie  

Konwencja stosowana w animacji, zgodnie z którą atrakcyjne dla widza jest 

przedstawianie przejaskrawionych ruchów. Klasyczna, sformułowana przez Disneya, 

zasada przejaskrawienia, nakazywała pozostawiać prawdę w realności, po prostu 

pokazując ją w szerszej, bardziej ekstremalnej formie. Inne formy przejaskrawienia 
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dopuszczają surrealizm, hiperrealizm i zróżnicowanie w cechach fizycznych danego 

bohatera. 

Rysunek przestrzenny  

Zasada rysunku przestrzennego odnosi się do uwzględniania trójwymiarowości 

przedstawianych obiektów, co wymaga od rysownika znajomości podstaw ludzkiej 

anatomii, kompozycji i umiejętności posługiwania się światłocieniem. W klasycznej 

animacji sprowadza się to do studium aktu i rysunków z natury. Należy pamiętać o 

proporcjach i odpowiednich kształtach obiektów w różnych fazach ruchu. 

Urok  

Coś, co w animacji odpowiada charyzmie aktora. Postać, która pojawia się na ekranie nie 

musi być sympatyczna – ważne jest, by odbiorca czuł, że postać jest prawdziwa i 

interesująca. 
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Animacja na podstawie klatek czasu - #frame 

Animacje, które mają się powtarzać ciągle, można stworzyć z uwzględnieniem wartości 

aktualnej klatki na osi czasie (#frame). Najłatwiej zrobić to za pomocą Driverów. 

W wielu przypadkach pomocne będzie użycie funkcji matematycznych, np. sine, które 

pozwolą zmieniać wartości cyklicznie. 

 

W przykładzie poniżej, przezroczystość obiektu będzie się zmieniać cyklicznie na 

podstawie numeru klatki na osi czasu. 
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Driver expressions 

W wyrażeniach Driverów można dodawać liczby, działania matematyczne i funkcje, np.: 

Glabals : frame 

Constants: pi, True, False 

Operators: +, -, *, /, ==, !=, <, <=, >, >=, and, or, not, conditional operator / tenary 

Math functions: min, max, radians, degrees, abs, fabs, floor, ceil, trunc, round, int, sin, cos, 

tan, asin, acos, atan, atan2, exp, log, sqrt, pow, fmod 

lerp, clamp, smoothstep 

Doc: https://docs.blender.org/manual/en/latest/animation/drivers/drivers_panel.html 
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Animacja twarzy z kontrolerem 

 

 

Driver do przesuwu tekstury wzdłuż osi x. 

round((var + offset) / distance) / quantity) 

 

offset odsunięcie pozycji x kontrolera od punktu 

Origin rodzica 

distance odległość między elementami tekstury 

(pojedynczymi wyrazami twarzy) 

quantity ilość wszystkich wyrazów twarzy na teksturze 

 

Link do materiałów 
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Geometry nodes 

 

Typy połączeń nodów 
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Efekt fali (Grid, Set Position, Noise Texture) 
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Instance on Points 
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Wybór losowych instancji z Collection 

Wybrana Kolekcja zawiera 3 obiekty 
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Animacja obrotu każdej losowej instancji z kolekcji w osi Z 

 

 

Tworzenie obiektów z cegieł 
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Time counter digits 
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Kompozycja, VFX, Edycja wideo 

Klip wideo + scena 3D 

Aby połączyć obiekty 3D z filmem wideo musimy załadować film oraz stworzyć nody w 

workspace Compositing. 

W workspace Compositing zaznacz opcję Use Nodes. 

Dodaj nod Movie Clip (Shift + A) i załaduj klip. Aby połaczyć nod Movie Clip i Render Layers 

należy dodać nod Alpha Over. 

 

Aby widzieć film w kamerze należy w ustawieniach kamery załadować go jako 

Background Images. 

 

Pamiętaj, by włączyć opcję Transparent w 

Render Properties > Film 
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Motion tracking 

Aby śledzić ruch w pliku wideo, najłatwiej jest przełączyć się do workspace Motion 

Tracking. Na początek otwieramy film lub sekwencję obrazów. 

W zależności od potrzeb należy dodać odpowiednią ilość markerów, które będą śledzić 

położenie pikseli w obrazie i na ich podstawie tworzyć ścieżkę ruchu.  

W zależności od sposobu nagrania filmu należy wybrać opcję Motion Model, najczęściej 

używanymi opcjami jest Perspective i Location, Rotation, Scale. 

 

Po ustawieniu markerów należy ustawić się w pierwszej klatce i stworzyć ścieżkę poprzez 

polecenie Track > Track Motion > Forwards (skrót Ctrl + T). 
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Jeżeli zamierzamy wykorzystać utworzoną ścieżkę dla obiektu na scenie, możemy 

stworzyć obiekt Empty, który będzie zawierał utworzoną ścieżkę ruchu. Robimy to w 

zakładce Solve > Geometry > Link Empty to Track. 

 

Jeżeli chcemy, na podstawie markerów, utworzyć ruch kamery, zaznaczamy opcję 

Keyframe, wybieramy opcje Refine i klikamy przycisk Solve Camera Motion. Do 

ustawienia kamery potrzeba przynajmniej 8 dobrych markerów. Po pomyślnym 

ustawieniu kamery pojawi się informacja o poziomie błędu (Solve error), zazwyczaj 

wartość poniżej 0.5px jest bardzo dobra. 

 

Na koniec, w polu Scene Setup, należy kliknąć przycisk Setup Tracking Scene. To również 

doda odpowiednie nody w workspace Compositing. 

 

Pamiętaj, by włączyć opcję Transparent w Render Properties > Film 
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